
 
 PIC24FJ64GU205 Curiosity Nano 开发板用户指南

前言

PIC24FJ64GU205 Curiosity Nano 评估工具包是一款硬件平台，用于评估 PIC24FJGU205 系列单片机。该评估板上装

有 PIC24FJ64GU205 单片机（MCU）。

该评估板受 MPLAB® X IDE 支持，能够轻松访问 PIC24FJ64GU205 的功能，从而探索如何将器件集成到定制设计

中。

Curiosity Nano 系列评估板配有板上调试器，无需借助外部工具即可对 PIC24FJ64GU205 进行编程和调试。

• MPLAB X IDE ——用于探索、配置、开发、编程和调试 Microchip 单片机的软件。

• 代码示例——借助代码示例入门。

• PIC24FJ64GU205 网站——查找文档、数据手册和样片，以及购买单片机。

• PIC24FJ64GU205 Curiosity Nano 网站——工具包信息、最新用户指南和设计文档。
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1. 简介

1.1 特性
• PIC24FJ64GU205 单片机

• 1 个黄色用户 LED
• 1 个机械用户开关

• 提供 32.768 kHz 晶振的安装位置

• Micro-USB 连接器，便于使用 PIC24FJ64GU205 上集成的 USB 外设开发 USB 设备应用

• 板上调试器：

– Microchip MPLAB X IDE 中的评估板标识

– 1 个绿色电源和状态 LED
– 编程和调试

– 虚拟串行端口（CDC）

– 一个调试 GPIO 通道（DGI GPIO）

• USB 供电

• 可调目标电压：

– MIC5353 LDO 稳压器，由板上调试器控制

– 1.8-3.6V 输出电压（受 USB 输入电压限制）

– 500 mA 最大输出电流（受环境温度和输出电压限制）

1.2 评估板概览
Microchip PIC24FJ64GU205 Curiosity Nano 评估工具包是一款用于评估 PIC24FJ64GU205 单片机的硬件平台。

图 1-1. PIC24FJ64GU205 Curiosity Nano 评估板概览
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2. 入门

2.1 快速入门
请按照以下步骤探索 PIC24FJ64GU205 Curiosity Nano 评估板：

1. 下载 Microchip MPLAB X IDE。
2. 下载 MPLAB XC C 编译器。

3. 启动 MPLAB X IDE。
4. 可选：使用 MPLAB®代码配置器生成驱动程序和示例。

5. 编写应用程序代码。

6. 使用一条 USB 线缆（Standard-A 转 Micro-B 或 Micro-AB）连接 PC 与评估板上的调试 USB 端口。

2.1.1 驱动程序安装

当评估板首次连接到计算机时，操作系统将安装驱动程序软件。驱动程序文件支持 32 位和 64 位版本的 Microsoft®
Windows® XP、Windows Vista、Windows 7、Windows 8 和 Windows 10。评估板的驱动程序随 MPLAB X IDE 一起

提供。

2.1.2 工具包窗口

评估板上电后，绿色状态 LED 将点亮，MPLAB X IDE 将自动检测连接了哪些评估板。MPLAB X IDE 中的 Kit Window
（工具包窗口）将提供相关信息，例如数据手册和评估板文档。PIC24FJ64GU205 Curiosity Nano 评估板上的

PIC24FJ64GU205 器件由板上调试器进行编程和调试，因此无需外部编程器或调试器工具。

提示： 如果关闭了 Kit Window，可通过 MPLAB X IDE 中的菜单栏 Window > Kit Window（窗口 > 工具包

窗口）重新打开。

2.1.3 MPLAB X IDE 器件系列包

Microchip MPLAB X IDE 需获取特定的信息才能支持器件和工具。此信息包含在各版本器件系列包中。对于

PIC24FJ64GU205 Curiosity Nano 评估板，需要具有器件系列包“PICxx”版本 x.y.z 和工具包“nEDBG_TP”版本

x.y.z 或更高版本的 Microchip MPLAB X IDE 版本 5.45。有关器件系列包及其升级途径的更多信息，请参见 MPLAB®

X IDE 用户指南——使用器件包。

提示： 最新的器件系列包可通过 MPLAB X IDE 中的 Tools > Packs（工具 > 包）获取，或者访问

Microchip MPLAB® X 包资源库在线下载。

2.2 设计文档和相关链接
下面列出了 PIC24FJ64GU205 Curiosity Nano 评估板的大部分相关文档和软件的链接：

• MPLAB X IDE——MPLAB X IDE 是一款运行于 PC（Windows、macOS®和 Linux®）的软件程序，为 Microchip
单片机和数字信号控制器开发应用程序。它被称为集成开发环境（Integrated Development Environment，
IDE），因为它提供了一个集成的“环境”来为嵌入式单片机开发代码。

• MPLAB® XC 编译器 ——MPLAB XC16 C 编译器可以免费下载，且使用不受限制。Microchip 的 MPLAB XC16 C
编译器是一套全面的解决方案，可在 Windows、macOS 或 Linux 操作系统中为您的项目进行软件开发。MPLAB
XC16 支持所有 16 位 PIC® MCU 和 dsPIC®数字信号控制器（Digital Signal Controller，DSC）。
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• MPLAB®代码配置器——MPLAB 代码配置器（MPLAB Code Configurator，MCC）是一款免费的软件插件，提

供图形界面以允许用户根据具体应用配置外设和功能。

• Microchip 样片商店——通过 Microchip 样片商店，您可以订购器件的样片。

• MPLAB 数据可视化器——MPLAB 数据可视化器是用于处理和可视化数据的程序。数据可视化器可以从各种来源

（例如，Curiosity Nano 和 Xplained Pro 板上的串行端口和板上调试器数据网关接口）接收数据。

• Microchip PIC®和 AVR®示例 ——Microchip PIC 和 AVR 器件示例是使用 Microchip 开发板演示 PIC 和 AVR 器

件外设用法的示例与实验的集合。

• Microchip PIC®和 AVR®解决方案 ——Microchip PIC 和 AVR 器件解决方案提供了完备的应用程序与 Microchip
开发板搭配使用，并且支持调整与扩展。

• PIC24FJ64GU205 Curiosity Nano 网站——工具包信息、最新用户指南和设计文档。

• Microchip 直销网站上的 PIC24FJ64GU205 Curiosity Nano——在 Microchip 直销网站上购买该工具包。
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3. Curiosity Nano
Curiosity Nano 是一个评估平台，它提供了一套小型评估板，可访问大多数单片机 I/O。该平台包含一系列带有板上调

试器的低引脚数单片机（MCU）评估板，这些评估板与 MPLAB X IDE 集成。每个评估板均可在 IDE 中被识别到。插

入后将显示 Kit Window，其中包含主要文档（包括相关的用户指南、应用笔记、数据手册和示例代码）的链接。任何

内容都很容易找到。板上调试器配有一个用于与主机 PC 进行串行通信的虚拟串行端口（CDC）以及一个具有调试

GPIO 引脚的数据网关接口（Data Gateway Interface，DGI）。

3.1 板上调试器概述
PIC24FJ64GU205 Curiosity Nano 配有用于编程和调试的板上调试器。板上调试器是一个包含多个接口的复合 USB 设

备：

• 可在 MPLAB X IDE 中对 PIC24FJ64GU205 进行编程和调试的调试器

• 可对 PIC24FJ64GU205 进行拖放编程的大容量存储设备

• 连接到 PIC24FJ64GU205 上的通用异步收发器（Universal Asynchronous Receiver/Transmitter，UART）的虚拟

串行端口（CDC），便于通过终端软件与目标应用程序通信

• 数据网关接口（Data Gateway Interface，DGI），可与逻辑分析器通道（调试 GPIO）配合用于代码插装以可视

化程序流

板上调试器控制 PIC24FJ64GU205 Curiosity Nano 评估板上的电源和状态 LED（标记为 PS）。下表列出了在不同的

工作模式下如何控制 LED。

表 3-1. 板上调试器 LED 控制

工作模式 电源和状态 LED

引导模式 上电期间 LED 慢速闪烁

上电 LED 点亮

正常工作 LED 点亮

编程 活动指示灯：LED 在编程/调试期间慢速闪烁

拖放编程
成功： LED 慢速闪烁 2s。

失败： LED 快速闪烁 2s。

故障 如果检测到电源故障，LED 会快速闪烁

休眠/关闭 LED 熄灭。板上调试器处于休眠模式或掉电。如果评估板由外部供电，则可能会发生

这种情况。

信息： 慢速闪烁频率约为 1 Hz，快速闪烁频率约为 5 Hz。

3.1.1 调试器

PIC24FJ64GU205 Curiosity Nano 评估板的板上调试器在主机计算机的 USB 子系统上充当人机接口设备（Human
Interface Device，HID）。调试器支持使用 MPLAB X IDE 对 PIC24FJ64GU205 进行全功能编程和调试。
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切记： 使调试器的固件保持最新。使用 MPLAB X IDE 时，固件会自动升级。

3.1.2 虚拟串行端口（CDC）

虚拟串行端口（CDC）是主机 PC 与目标器件之间的通用串行桥接器。

3.1.2.1 概述

板上调试器实现了一个复合 USB 设备，其中包括标准的通信设备类（Communications Device Class，CDC）接口，

该接口在主机上充当虚拟串行端口。CDC 可用于在主机计算机与目标之间双向传输任意数据：通过主机计算机上的虚

拟串行端口发送的所有字符将作为 UART 字符在调试器的 CDC TX 引脚上发送，而在调试器的 CDC RX 引脚上捕捉的

UART 字符将通过虚拟串行端口返回给主机计算机。

图 3-1. CDC 连接

Target MCU

UART TX

UART RX

Debugger

USB
CDC RX

CDC TX

PC
Terminal
Software

Target
Receive

Target
Send

Terminal
Receive

Terminal
Send

信息： 如图 3-1 所示，调试器的 CDC TX 引脚连接到目标 MCU 上的 UART RX 引脚以从主机计算机接收字

符。同样，调试器的 CDC RX 引脚连接到目标 MCU 上的 UART TX 引脚以向主机计算机发送字符。

3.1.2.2 操作系统支持

在 Windows 计算机上，CDC 将枚举为 Curiosity Virtual COM Port（Curiosity 虚拟 COM 端口），并显示在 Windows
Device Manager（设备管理器）的 Ports（端口）部分。COM 端口号也显示在此处。

信息： 在旧版 Windows 系统上，CDC 需要 USB。该驱动程序随 MPLAB X IDE 一同安装。

在 Linux®计算机上，CDC 将枚举并显示为/dev/ttyACM#。

信息： 在 Linux 中，tty*设备属于“dialout”组，因此可能需要成为该组的成员才有权访问 CDC。

在 Mac®计算机上，CDC 将枚举并显示为/dev/tty.usbmodem#。根据所使用的终端程序，CDC 将以 usbmodem#
的形式显示在可用调制解调器列表中。
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信息： 对于所有操作系统：确保使用支持 DTR 信号的终端仿真器。请参见 3.1.2.4  信号传输。

3.1.2.3 限制

板上调试器 CDC 中并未实现所有 UART 功能。相关限制汇总如下：

• 波特率：必须处于 1200 bps 至 500 kbps 的范围内。任何超出此范围的波特率都将设置为最接近的限值，而不会

发出警告。波特率可以在运行过程中更改。

• 字符格式：仅支持 8 位字符。

• 奇偶校验：可以是奇校验、偶校验或无奇偶校验。

• 硬件流控制：不支持。

• 停止位：支持一个或两个停止位。

3.1.2.4 信号传输

在 USB 枚举期间，主机 OS 将启动 CDC 接口的通信和数据管道。此时，可以设置和读回 CDC 的波特率和其他 UART
参数，但是不会使能数据发送和接收。

当终端连接到主机时，主机必须将 DTR 信号置为有效。由于这是在 USB 接口上实现的虚拟控制信号，因此并不会实

际出现在评估板上。主机将 DTR 信号置为有效时会向板上调试器指示 CDC 会话处于活动状态。调试器随后将使能其

电平转换器（如果可用），并启动 CDC 数据发送和接收机制。

在调试器固件版本 1.20 或更低版本中将 DTR 置为无效时的行为如下：

• 禁止调试器 UART 接收器，因此不会再向主机计算机传输数据

• 调试器 UART 发送器将继续发送排队等待发送的数据，但不会再接受来自主机计算机的任何新数据

• 不会禁止电平转换器（如果可用），并且调试器 CDC TX 线将保持驱动状态

在调试器固件版本 1.21 或更高版本中将 DTR 置为无效时的行为如下：

• 禁止调试器 UART 接收器，因此不会再向主机计算机传输数据

• 调试器 UART 发送器将继续发送排队等待发送的数据，但不会再接受来自主机计算机的任何新数据

• 完成正在进行的传输后将禁止电平转换器（如果可用），因此调试器 CDC TX 线将变为高阻态

切记： 设置终端仿真器以将 DTR 信号置为有效。如果没有该信号，板上调试器将不会通过其 UART 发送或

接收任何数据。

提示： 在主机计算机使能 CDC 接口之前，不会驱动板上调试器的 CDC TX 引脚。而且，在连接调试器和目

标板的 CDC 线上没有外部上拉电阻，这意味着在上电期间，这些线处于悬空状态。为了避免出现任何会导

致不可预测行为（例如帧错误）的毛刺，目标器件可以在连接到调试器 CDC TX 引脚的引脚上使能内部上

拉电阻。

3.1.2.5 高级用途

CDC 改写模式

正常工作时，板上调试器实际上充当主机与设备之间的 UART 桥接器。但在某些用例中，板上调试器可以改写基本工

作模式，将 CDC TX 和 RX 引脚用于其他用途。

通过将一个文本文件拖放到板上调试器的大容量存储驱动器，可以从调试器的 CDC TX 引脚发送字符。文件名和扩展

名不重要，但文本文件必须以如下字符开头：

CMD:SEND_UART=
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调试器固件版本 1.20 或更低版本具有以下限制：

• 最大报文长度为 50 个字符，帧中的所有剩余数据都将被忽略。

• 在该模式下使用的默认波特率为 9600 bps，但如果 CDC 已处于活动状态或已完成配置，则之前使用的波特率仍

适用。

调试器固件版本 1.21 及更高版本具有以下限制/特性：

• 最大报文长度取决于主机计算机和/或操作系统上的 MSC/SCSI 层超时。保证单个 SCSI 帧为 512 字节（有效负载

为 498 个字符），并且在大多数系统上可以使用最大 4 KB 的文件。传输将在文件中出现第一个 NULL 字符时完

成。

• 默认命令使用的波特率始终为 9600 bps：
CMD:SEND_UART=

• 请勿在通过 CDC/终端进行数据传输的同时使用 CDC 改写模式。当通过 CDC 改写模式接收文件时，如果 CDC 终

端会话处于活动状态，则该会话将在接收文件期间暂停，并在文件接收完毕后恢复。

• 支持具有明确波特率的附加命令：

CMD:SEND_9600=

CMD:SEND_115200=

CMD:SEND_460800=

USB 级成帧注意事项

从主机向 CDC 发送数据可按字节或以块的形式进行，这些数据将被分为 64 字节的 USB 帧。每个此类帧都将排队等待

发送到调试器的 CDC TX 引脚。每帧传输少量数据会造成效率低下，特别是在低波特率下，因为板上调试器缓存帧而

不是字节。最多支持 4 个 64 字节的帧同时处于有效状态。板上调试器将相应地限制传入的帧。发送包含数据的完整

64 字节帧是最高效的方法。

当在调试器的 CDC RX 引脚上接收数据时，板上调试器会将传入的字节排成 64 字节的帧，并在帧的 64 字节已满时将

其发送到 USB 队列，最终发送到主机。不完整帧也会以大约 100 ms 的间隔被推入 USB 队列（由 USB 帧起始令牌触

发）。最多支持 8 个 64 字节的帧同时处于有效状态。

如果主机（或在主机上运行的软件）接收数据的速度不够快，则会发生溢出。发生这种情况时，最后填充的缓冲区帧

将被回收（而不是发送到 USB 队列），并且整个数据帧将丢失。为了防止发生这种情况，用户必须确保连续读取

CDC 数据管道，或者必须降低传入数据的速率。

3.1.3 大容量存储设备

板上调试器实现了一个简单的大容量存储设备，可通过与其连接的主机操作系统进行读/写操作。

它支持：

• 读取基本文本和 HTML 文件，以便获取详细的工具包信息和支持

• 通过写访问将 Intel® HEX 格式的文件编程到目标器件的存储器中

• 写入简单文本文件，以便能够使用实用程序命令

3.1.3.1 大容量存储设备实现

板上调试器实现了 FAT12 文件系统的高度优化版本，该版本仍存在一些限制，部分原因在于 FAT12 本身的性质以及为

实现其嵌入式应用程序用途而进行的优化。

Curiosity Nano USB 设备符合 USB 第 9 章的要求，可充当大容量存储设备，但无论如何都不能作为通用大容量存储设

备使用，这是有意设计的。

使用 Windows 操作系统时，板上调试器枚举为 Curiosity Nano USB 设备，可以在设备管理器的磁盘驱动器部分找

到。CURIOSITY 驱动器显示在文件管理器中，并声明系统中下一个可用的驱动器号。

CURIOSITY 驱动器包含大约 1 MB 的可用空间，但这丝毫不会影响目标器件闪存的大小。编程 Intel 十六进制文件时，

二进制数据以 ASCII 编码，其中元数据的开销较大，因此相对于磁盘大小来说，1 MB 可忽略不计。
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无法格式化 CURIOSITY 驱动器。将文件编程到目标器件时，文件名可能会出现在磁盘目录列表中。这只是操作系统

的目录视图，实际上并未更新。无法读出文件内容。拔出评估板并重新插入时，文件系统将恢复其原始状态，但目标

器件仍将包含先前已编程的应用程序。

要擦除目标器件，请将一个以“CMD:ERASE”开头的文本文件复制到磁盘上。

默认情况下，CURIOSITY 驱动器包含多个只读文件，用于生成图标以及报告状态和链接到更多信息：

• AUTORUN.ICO ——Microchip 徽标的图标文件

• AUTORUN.INF ——Windows 资源管理器显示图标文件时所需的系统文件

• KIT-INFO.HTM ——重定向到开发板网站

• KIT-INFO.TXT ——包含有关评估板的调试器固件版本、评估板名称、USB 序列号、器件和拖放支持的详细信

息的文本文件

• STATUS.TXT ——包含评估板编程状态的文本文件

信息： STATUS.TXT 由板上调试器动态更新。其内容可能会被操作系统缓存，因此不会反映正确的状态。

3.1.3.2 配置字

配置字（PIC MCU 目标器件）

完成程序闪存编程后，配置字设置包含在已编程的项目中。调试器在写入配置字时不会掩码掉其中的任何位，但是由

于它使用低电压编程模式，因此无法清零 LVP 配置位。如果由于选择了错误的时钟源等原因而导致评估板无法引导，

则始终可以执行批量擦除（始终在编程之前执行），将器件恢复为其默认设置。

3.1.3.3 特殊命令

通过将文本文件复制到大容量存储磁盘，可以支持多条实用程序命令。文件名或扩展名无关紧要——命令处理程序仅

对内容做出反应。

表 3-2. 特殊文件命令

命令内容 说明

CMD:ERASE 对目标器件执行全片擦除

CMD:SEND_UART= 将字符串发送到 CDC UART。请参见“CDC 改写模式”。

CMD:SEND_9600=
CMD:SEND_115200=
CMD:SEND_460800=

以指定的波特率将字符串发送到 CDC UART。请注意，仅支持

此处明确指定的波特率！请参见“CDC 改写模式”。（调试器

固件 v1.21 或更高版本。）

CMD:RESET 通过进入编程模式并随即退出来复位目标器件。确切的时序取决
于目标器件的编程接口。（调试器固件 v1.16 或更高版本。）

CMD:POWERTOGGLE 使目标板掉电并在 100 ms 延时后恢复上电。如果提供外部电

源，则无效。（调试器固件 v1.16 或更高版本。）

CMD:0V 通过禁止目标电源稳压器使目标器件掉电。如果提供外部电源，

则无效。（调试器固件 v1.16 或更高版本。）

CMD:1V8 将目标电压设置为 1.8V。如果提供外部电源，则无效。（调试器

固件 v1.21 或更高版本。）

CMD:3V3 将目标电压设置为 3.3V。如果提供外部电源，则无效。（调试器

固件 v1.16 或更高版本。）

CMD:5V0 将目标电压设置为 5.0V。如果提供外部电源，则无效。（调试器

固件 v1.16 或更高版本。）
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信息： 发送到大容量存储仿真磁盘的内容将触发此处列出的命令，但无论成功还是失败都不会提供任何反

馈。

3.1.4 数据网关接口（DGI）
数据网关接口（DGI）是一个 USB 接口，用于在板上调试器和基于主机计算机的可视化工具之间传输原始数据和带有

时间戳的数据。主机计算机上使用 MPLAB 数据可视化器显示调试 GPIO 数据。该可视化工具既可以作为 MPLAB X
IDE 的插件使用，也可以作为独立的应用程序与 MPLAB X IDE 并行使用。

尽管 DGI 包含多个物理数据接口，但 PIC24FJ64GU205 Curiosity Nano 实现仍包含逻辑分析器通道：

• 一个调试 GPIO 通道（也称为 DGI GPIO）

3.1.4.1 调试 GPIO
调试 GPIO 通道是带有时间戳的数字信号线，用于将目标应用连接到主机计算机的可视化应用程序。它们通常用于基

于时间轴绘制发生的低频事件——例如，当发生某些应用状态转换时。

下图给出了在 MPLAB 数据可视化器中监视到的调试 GPIO 所连机械开关的数字状态。

图 3-2. 使用 MPLAB®数据可视化器监视调试 GPIO

调试 GPIO 通道带有时间戳，因此 DGI GPIO 事件的分辨率取决于 DGI 时间戳模块的分辨率。

重要： 尽管可以捕捉更高频率信号的突发，但可使用调试 GPIO 捕捉的信号的有用频率范围最高为 2 kHz
左右。如果尝试捕捉高于此频率的信号，则将发生数据饱和及溢出，这可能会导致 DGI 会话中止。

3.1.4.2 时间戳
DGI 源由调试器捕捉时带有时间戳。在 Curiosity Nano 调试器中实现的时间戳计数器以 2 MHz 的频率递增，可提供半

微秒的时间戳分辨率。

3.2 Curiosity Nano 标准引脚排列
最接近 Curiosity Nano 评估板上 USB 连接器的 12 个边缘连接具有标准化的引脚排列。编程/调试引脚具有不同的功

能，具体取决于目标编程接口，如以下图表中所示。
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表 3-3. Curiosity Nano 标准引脚排列

调试器信号 目标 MCU 说明

ID — 用于扩展的 ID 线

CDC TX UART RX USB CDC TX 线

CDC RX UART TX USB CDC RX 线

DBG0 ICSPDAT 调试数据线

DBG1 ICSPCLK 调试时钟线

DBG2 GPIO0 调试 GPIO0

DBG3 MCLR 复位线

NC — 无连接

VBUS — 供外部使用的 VBUS 电压

VOFF — 电压关闭输入。拉低时禁止目标稳压器和目标电压。

VTG — 目标电压

GND — 公共接地端

图 3-3. Curiosity Nano 标准引脚排列

USB

DEBUGGER

PS LED
NC

ID

CDC RX

CDC TX

DBG1

DBG2

VBUS

VOFF

DBG3

DBG0

GND

VTGCURIOSITY NANO

3.3 电源
评估板通过两个 USB 端口之一供电并包含两个 LDO 稳压器，其中一个 LDO 稳压器用于为板上调试器生成 3.3V 电

压，另一个可调 LDO 稳压器用于为目标 PIC24FJ64GU205 单片机及其外设供电。来自 USB 连接器的电压为 4.4V 至

5.25V（根据 USB 规范），这将限制提供给目标板的最大电压。下图给出了 PIC24FJ64GU205 Curiosity Nano 上的整

个电源系统。
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图 3-4. 电源框图
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Target
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Power
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信息： 电源多路开关（MUX）允许通过两个 USB 端口之一为评估板供电。如果同时连接了两个 USB 电

源，则多路开关将选择目标 USB 端口为评估板供电。

3.3.1 目标稳压器

目标稳压器是 MIC5353 可变输出 LDO。板上调试器可以通过控制 MIC5353 的反馈电压来调整为评估板目标部分供电

的电压输出。硬件实现将电压限制在 1.7V 至 5.1V 的近似范围内。调试器固件中配置了其他输出电压限制，以确保输

出电压绝不会超过 PIC24FJ64GU205 单片机的硬件限制。PIC24FJ64GU205 Curiosity Nano 的板上调试器中配置的电

压限制为 2.0-3.6V。

信息： 评估板的目标电压在制造阶段设置为 3.3V。用户可以通过 MPLAB X IDE 项目属性进行更改。对目

标电压进行的任何更改都是永久性的，即使是切换电源后也依然适用。分辨率小于 5 mV，但可通过调整程

序限制为 10 mV。

信息： 在 MPLAB X IDE 中进行的电压设置不会立即应用到评估板上。无论以何种方式访问调试器（例如，

按下项目仪表板选项卡中的“Refresh Debug Tool”（刷新调试工具）按钮或编程/读取程序存储器）时，都

会将新的电压设置应用到评估板上。

信息： 可通过拖放命令文本文件到评估板来轻松调整目标电压，该方法支持一组常见的目标电压。更多详

细信息，请参见 3.1.3.3  特殊命令。

MIC5353 支持最大 500 mA 的电流负载。这是一个采用小型封装的 LDO 稳压器（位于小型印刷电路板（Printed
Circuit Board，PCB）上），在低于 500 mA 的电流负载下可以达到热关断条件。最大电流负载取决于输入电压、选定

的输出电压和环境温度。下图给出了输入电压为 5.1V 且环境温度为 23°C 时稳压器的安全工作区域。
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图 3-5. 目标稳压器安全工作区域

目标稳压器的电压输出由板上调试器连续监视（测量）。如果比所设置器件电压高/低 100 mV 以上，将标记错误条

件，并且目标稳压器将关闭。这样便可检测所有短路情况并加以处理。此外，还会检测是否有在未将 VOFF 引脚设置

为低电平的情况下向 VTG 引脚突然施加会导致 VCC_TARGET 超出±100 mV 电压设置监视窗口的外部电压并加以处

理。

信息： 板上调试器的监视窗口为 VCC_TARGET±100 mV。如果外部电压低于此限制，则板上调试器状态

LED 将快速闪烁。如果外部电压高于此限制，则板上调试器状态 LED 将继续点亮。如果移除外部电压，状

态 LED 将开始快速闪烁，直到板上调试器检测到新情况并重新开启目标稳压器为止。

3.3.2 外部电源

可以使用外部电压代替板上目标稳压器为 PIC24FJ64GU205 Curiosity Nano 供电。当电压关闭（VOFF）引脚短接到

地（GND）时，板上调试器固件将禁止目标稳压器，可以安全地将外部电压施加到 VTG 引脚上。

当板上 DEBUG 连接器中未插入 USB 线缆时，也可以安全地将外部电压施加到 VTG 引脚上。

可以随时将 VOFF 引脚连接至低电平/悬空。这将通过发送到板上调试器的引脚电平变化中断检测到，板上调试器随后

将相应地控制目标稳压器。

WARNING 在不将 VOFF 短接到 GND 的情况下，向 VTG 引脚施加外部电压可能会对评估板造成永久性损坏。

WARNING 请勿向 VOFF 引脚施加任何电压。将该引脚悬空，以便使能电源。

WARNING 板上电平转换器的绝对最大外部电压为 5.5V，PIC24FJ64GU205 的标准工作条件为 2.0-3.6V。施加更高的

电压可能会对评估板造成永久性损坏。
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信息： 如果在未将 VOFF 引脚拉低的情况下施加了外部电压，并且外部电源将电压拉至监视窗口的下限

（目标电压设置值 – 100 mV）以下，则板上调试器状态 LED 将快速闪烁，板上稳压器将关闭。如果在未

将 VOFF 引脚拉低的情况下突然移除了外部电压，则此状态 LED 将开始快速闪烁，直到板上调试器检测到

新情况并重新开启目标稳压器为止。

使用外部电源时，仍然可以进行编程、调试和数据传输——调试器和信号电平转换器将通过 USB 线缆供电。拔下 USB
线缆后，两个稳压器、调试器和电平转换器均会掉电。

信息： 当板上 DEBUG 连接器中插入 USB 线缆时，除了 PIC24FJ64GU205 及其外设的功耗外，还会从任

何外部电源汲取大约 100 µA 的电流来为板上电平转换器和电压监视电路供电。未插入 USB 线缆时，也会

消耗一部分电流为电平转换器电压引脚供电，最坏情况下的电流消耗约为 5 µA，典型值可能低至 100 nA。

3.3.3 VBUS 输出引脚

PIC24FJ64GU205 Curiosity Nano 具有 VBUS 输出引脚，可用于为需要 5V 电源的外部元件供电。VBUS 输出引脚配

有 PTC 熔丝，可防止 USB 短路。PTC 熔丝的副作用是，当电流负载较高时，VBUS 输出会发生压降。下图给出了

VBUS 输出的电压与电流负载的关系。

图 3-6. VBUS 输出电压与电流的关系

3.3.4 电源异常

本节汇总了电源可能出现的大多数异常。
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目标电压关断
如果目标部分在给定的电压下汲取了过多电流并导致 MIC5353 稳压器的热关断安全功能启动，则可能发生此异常。为

避免发生此异常，请降低目标部分的电流负载。

未达到目标电压设置值
USB 输入电压（指定为 4.4V-5.25V）限制了最大输出电压（即给定电压设置值和电流消耗下 MIC5353 稳压器上的压

降）。如果需要更高的输出电压，请使用可提供更高输入电压的 USB 电源，或者在 VTG 引脚上使用外部电源。

目标电压与设置值不同
可能的原因是在未将 VOFF 引脚设置为低电平的情况下从外部向 VTG 引脚施加了电压。如果目标电压比电压设置值

高/低 100 mV 以上，则会被板上调试器检测到，随后内部稳压器将关闭。要解决此问题，请从 VTG 引脚上移除施加的

电压，板上调试器将在检测到新情况时使能板上稳压器。请注意，当目标电压比设置值低 100 mV 以上时，PS LED 将

快速闪烁，但是当目标电压比设置值高 100 mV 以上时，PS LED 通常将点亮。

目标电压不存在或极低，PS LED 快速闪烁

这是上述问题的特例，可能是由于完全或部分短路引起。请消除短路条件，板上调试器随后将重新使能板上目标稳压

器。

目标电压不存在且 PS LED 点亮 1
如果目标电压设置为 0.0V，则会发生此异常。要解决此问题，请将目标电压设置为目标器件指定电压范围内的值。

目标电压不存在且 PS LED 点亮 2
如果切断了电源跳线 J100 和/或 J101，并且将目标稳压器设置为目标器件指定电压范围内的值，则可能会出现该问

题。要解决此问题，请在 J100/J101 的焊盘之间焊接导线/桥接器，或者在 J101 上添加跳线（如果安装了排针）。

VBUS 输出电压低或不存在

这很可能是由于 VBUS 上的电流消耗较高导致保护熔丝（PTC）减小电流或完全切断电流而引起。减小 VBUS 引脚上

的电流消耗即可解决此问题。

3.4 低功耗测量
PIC24FJ64GU205 通过板上电源供电，或者经由丝印上标有“POWER”的 100 mil 排针（J101）通过 VTG 引脚供

电。要测量 PIC24FJ64GU205 和连接到评估板的其他外设的功耗，应切断目标电源配置脚并在配置脚上连接一个电流

表。

要测量可能的最低功耗，请按照下列步骤操作：

1. 用锋利的工具切断 POWER 配置脚。

2. 在配置脚位置上焊接一个 1x2 100 mil 排针。

3. 将电流表连接到该排针。

4. 编写固件：

4.1. 将连接到板上调试器的所有 I/O 置于三态。

4.2. 将单片机设置为其最低功耗休眠模式。

5. 将固件编程到 PIC24FJ64GU205 中。
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图 3-7. 目标电源配置脚

Target Power strap (top side)

提示： 可以将 100 mil 排针焊接到目标电源配置脚（J101）位置，以方便连接电流表。不再需要电流表后，

应在排针上放置一个跳线帽。

信息： 板上电平转换器即便不使用也会消耗少量电流。从连接到电平转换器的每个 I/O 引脚中最多可汲取 2
μA 电流，总共可汲取 10 μA 电流。应使所有与电平转换器连接的 I/O 引脚保持三态，以防止产生泄漏电

流。4.2.6.1  板上调试器连接列出了连接到板上调试器的所有 I/O。为了防止板上电平转换器产生任何泄漏电

流，可以将其完全断开连接，如 7.4  断开板上调试器的连接所述。

3.5 外部单片机编程
PIC24FJ64GU205 Curiosity Nano 的板上调试器可用于对外部硬件上的单片机进行编程和调试。

3.5.1 支持的器件

所有带有 UPDI 接口的外部 AVR 单片机均可以使用板上调试器通过 Microchip Studio 进行编程和调试。

具有 Curiosity Nano 评估板的外部 SAM 单片机可以使用板上调试器通过 Microchip Studio 进行编程和调试。

PIC24FJ64GU205 Curiosity Nano 可以使用 MPLAB X IDE 对外部 PIC24FJ64GU205 单片机进行编程和调试。

3.5.2 软件配置

无需软件配置即可对评估板上安装的器件进行编程和调试。

要对评估板上安装的单片机以外的单片机进行编程和调试，必须将 Microchip Studio 配置为允许自由选择器件和编程接

口。

1. 通过应用程序顶部的菜单系统导航到 Tools > Options（工具 > 选项）。

2. 在 Options 窗口中选择 Tools > Tool settings（工具 > 工具设置）类别。
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3. 将 Hide unsupported devices（隐藏不支持的器件）选项设置为 False（假）。

图 3-8. 隐藏不支持的器件

信息： 当 Hide unsupported devices 设置为 False 时，Microchip Studio 允许选择任何单片机和接口，板

上调试器不支持的单片机和接口也包括在内。

3.5.3 硬件修改

板上调试器默认连接到 PIC24FJ64GU205。在对任何外部单片机进行编程或调试之前，请断开这些连接。用锋利的工

具切断下图所示的 GPIO 配置脚，以将 PIC24FJ64GU205 与板上调试器断开连接。

 
Curiosity Nano

© 2021 Microchip Technology Inc.  用户指南 DS50003124A_CN-第 18 页



图 3-9. 调试器的编程和调试连接

GPIO straps (bottom side)

信息： 切断与调试器的连接将禁止对板上安装的 PIC24FJ64GU205 的编程、调试以及二者之间的数据传

输。

提示： 在配置脚位置上焊接 0Ω电阻或通过用焊料将其短路，以重新连接板上调试器与 PIC24FJ64GU205
之间的信号。

3.5.4 连接外部单片机

以下图表给出了对外部单片机进行编程和调试时，编程和调试信号的连接位置。板上调试器可以为外部硬件供电，或

使用外部电压作为其电平转换器的参考电压。有关电源的更多信息，请参见 3.3  电源。

板上调试器和电平转换器主动驱动用于编程和调试的数据和时钟信号（DBG0、DBG1 和 DBG2）。通常，这些信号上

无需外部电阻。ICSP™数据和时钟信号上需要连接下拉电阻才能调试 PIC 单片机。

DBG3 是漏极开路连接，需要一个上拉电阻才能正常工作。

PIC24FJ64GU205 Curiosity Nano 为 ICSP 数据和时钟信号（DBG0 和 DBG1）连接了下拉电阻 R204 和 R205。此

外，还为#MCLR 信号（DBG3）连接了上拉电阻 R200。上拉电阻的位置如附录的 7.2  装配图纸部分所示。

切记：

• 将 GND 和 VTG 连接到外部单片机

• 如果外部硬件有电源，则将 VOFF 引脚连接到 GND
• 确保 ICSP 数据和时钟信号（DBG0 和 DBG1）上有下拉电阻，以便支持对 PIC 单片机进行调试
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图 3-10. Curiosity Nano 标准引脚排列

USB

DEBUGGER

PS LED
NC

ID

CDC RX

CDC TX

DBG1

DBG2

VBUS

VOFF

DBG3

DBG0

GND

VTGCURIOSITY NANO

表 3-4. 编程和调试接口

Curiosity Nano 引脚 UPDI ICSP™ SWD

DBG0 UPDI DATA SWDIO

DBG1 — CLK SWCLK

DBG2 — — —

DBG3 — #MCLR #RESET

3.6 连接外部调试器
即使有板上调试器，也可以将外部调试器直接连接到 PIC24FJ64GU205 Curiosity Nano 来对 PIC24FJ64GU205 进行

编程/调试。当未使用与 PIC24FJ64GU205 和评估板边缘连接的引脚时，板上调试器会使这些引脚全部处于三态。因

此，板上调试器不会干扰任何外部调试工具。
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图 3-11. 将 MPLAB® PICkit™ 4 在线调试器/编程器连接到 PIC24FJ64GU205 Curiosity Nano

2345678 1

MCLR
VDD

Ground
DATACLOCK

3 = Ground

4 = PGD

5 = PGC

6 = Unused

7 = Unused

8 = Unused

2 = VDD

1 = MCLR

MPLAB® PICkit™ 4

USB

DEBUGGER

PS LED
NC

ID

CDC RX

CDC TX

DBG1

DBG2

VBUS

VOFF

DBG3

DBG0

GND

VTGCURIOSITY NANO

CAUTION MPLAB® PICkit™ 4 在线调试器/编程器能够在 MCLR 引脚上提供高电压。但高电压会导致 R110 永久损

坏。如果 R110 损坏，板上调试器无法进入 PIC24FJ64GU205 的编程模式，并且通常无法成功读取器件

ID。

CAUTION 为避免外部调试器与板上调试器之间发生争用，请勿在外部工具处于工作状态时使用板上调试器通过

MPLAB® X IDE 或者大容量存储编程来启动任何编程/调试操作。
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4. 硬件用户指南

4.1 连接器

4.1.1 PIC24FJ64GU205 Curiosity Nano 引脚排列

所有 PIC24FJ64GU205 I/O 引脚均可通过板上的边缘连接器进行访问。下图给出了评估板的引脚排列。

图 4-1. PIC24FJ64GU205 Curiosity Nano 引脚排列

USB

DEBUGGER

PIC24FJ64GU205

SW0

LED0

PS LED
NC

N
C

ID

ID

CDC RX

C
D
C
R
XTXRC9RP25

CDC TX
C
D
C
T
XRXRA11PRIN29

DBG1
D
B
G
1RA1ICSP_CLKPGC3

DBG2

D
B
G
2RA12RPIN30SW0

RC2

R
C
2RP18TX

RA13

R
A
1
3RPIN31RX

RB9

R
B
9RP9I2C SDA1

RB8

R
B
8RP8I2C SCL1

RC3

R
C
3RP19SPI MOSI

RC4

R
C
4RP20SPI MISO

RC5

R
C
5RP21SPI SCK

RB7

R
B
7RP7SPI SS

GND

G
N
D

RB5

R
B
5RP5TX

RA14

R
A
1
4RPIN32RX

RC8

R
C
8RP24

RC6

R
C
6RP22

RC1

R
C
1RP17LED

RA10

R
A
1
0RP28

RA2

R
A
2(OSCI)

RA3

R
A
3(OSCO)

GND

G
N
D

VBUS

V
B
U
S

VOFF

V
O
F
F

DBG3

D
B
G
3 MCLR

DBG0

D
B
G
0 RA0 ICSP_DAT PGD3

GND

G
N
D

VTG

V
T
G

RC0

R
C
0 RP16 AN10

RB3

R
B
3 RP3 AN5

RB2

R
B
2 RP2 AN4

RB1

R
B
1 RP1 AN3

RB0

R
B
0 RP0 AN2

RB15

R
B
1
5 RP15 AN9

RB14

R
B
1
4 RP14 AN6

RB13

R
B
1
3 RP13 AN7

GND

G
N
D

RA7

R
A
7

RA9

R
A
9

RA8

R
A
8

RC7

R
C
7 RP23

RC9

R
C
9 RP25 TX CDC_RX

RA11

R
A
1
1 RPIN29 RX CDC_TX

RA4

R
A
4 (SOSCO)

RB4

R
B
4 RP4 (SOSCI)

GND

G
N
D

DEBUGGER
PIC24FJ64GU205

Analog

Debug

I2C

SPI

UART

Peripheral

Port

Power

Ground

PPS

Shared pin

信息： 上图所示的外设信号（例如 UART、I2C、SPI、ADC 和 PWM 等）均按照 Curiosity Nano 评估板标

准显示在特定的引脚上。这些信号通常可以使用 PIC24FJ64GU205 中的外设引脚选择（Peripheral Pin
Select，PPS）功能连接到备用引脚。

4.1.2 使用排针

PIC24FJ64GU205 Curiosity Nano 上的边缘连接器采用交错设计，其中每个孔偏离中心 8 mil（约 0.2 mm）。由于孔

偏离中心，因此可在板上使用常规的 100 mil 排针，而无需焊接。排针固定到位后，便可用于引脚插座和原型板等常规

应用，而不会出现任何问题。
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图 4-2. 将排针安装到 Curiostiy Nano 板上

图 4-3. 连接到适用于 Click board™的 Curiosity Nano 基板

提示： 将排针从一端开始逐渐整个插入评估板。当整个排针固定到位后，借助平整表面将其推入。

提示： 对于将永久使用排针的应用，仍建议采用焊接的方式将排针固定到位。

重要： 排针固定到位后，很难用手取下。可以借助钳子之类的工具，但操作时务必小心谨慎，以免损坏排

针和 PCB。

4.2 外设

4.2.1 目标 USB 连接器

通过 PIC24FJ64GU205 上集成的 USB 外设开发 USB 设备应用程序时使用的 Micro USB 连接器。

4.2.2 LED
PIC24FJ64GU205 Curiosity Nano 板上有一个黄色的用户 LED，可通过 GPIO 或 PWM 进行控制。将连接的 I/O 线驱

动到 GND 也可以激活 LED。
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表 4-1. LED 连接

PIC24FJ64GU205 引脚 功能 共用功能

RC1 黄色 LED0 边缘连接器

4.2.3 机械开关

PIC24FJ64GU205 Curiosity Nano 板上有一个机械开关，这是一个通用的用户可配置开关。按下该开关后，会将 I/O
线驱动到地（GND）。

提示： 开关上没有外接上拉电阻。应确保在引脚 RA12 上使能了内部上拉电阻，以便能够正常使用开关。

表 4-2. 机械开关

PIC24FJ64GU205 引脚 说明 共用功能

RA12 用户开关（SW0） 边缘连接器和板上调试器

4.2.4 晶振

PIC24FJ64GU205 Curiosity Nano 配有一个 32.768 kHz 的晶振。

默认情况下，该晶振不连接到 PIC24FJ64GU205，因为 GPIO 连接到边缘连接器。要使用晶振，需要进行一些硬件修

改。必须在评估板上安装晶振 XC200（Abracon ABS07-32.768kHz-7-T）以及电容 C205（10 pF AVX
04025A100JAT2A）和 C206（13 pF Murata GRM1555C1H130JA01D）或类似器件。应断开连接到边缘连接器的两

条 I/O 线，以降低与晶振争用的几率并消除线路上的过量电容。可以通过切断评估板底部的两个配置脚（在下图中标记

为 RA4 和 RB4）来实现此目的。接下来，焊接评估板顶部晶振旁边的每个圆形焊接点，如下图所示。

表 4-3. 晶振连接

PIC24FJ64GU205 功能 共用功能

RA4 SOSCO（晶振输出） 边缘连接器

RB4 SOSCI（晶振输入） 边缘连接器

图 4-4. 晶振连接和切断配置脚
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4.2.5 目标 USB 连接器

通过 PIC24FJ64GU205 上集成的 USB 外设开发 USB 设备应用程序时使用的 Micro USB 连接器。

4.2.6 板上调试器实现

PIC24FJ64GU205 Curiosity Nano 具有一个板上调试器，可用于通过 ICSP 对 PIC24FJ64GU205 进行编程和调试。板

上调试器还包括通过 UART 连接的虚拟串行端口（CDC）接口和调试 GPIO。MPLAB X IDE 可用作板上调试器的前

端，以进行编程和调试。MPLAB 数据可视化器可用作 CDC 和调试 GPIO 的前端。

4.2.6.1 板上调试器连接

下表列出了目标器件和调试器部分之间的连接。只要调试器未在使用接口，目标器件和调试器之间的所有连接便处于

三态，因此信号污染很小并且可以根据用户要求配置引脚。

有关如何使用板上调试器功能的更多信息，请参见 3.1  板上调试器概述。

表 4-4. 板上调试器连接

PIC24FJ64GU20
5 引脚

调试器引脚 功能 共用功能

RC9 CDC TX UART RX（PIC24FJ64GU205 RX
线）

边缘连接器

RA11 CDC RX UART TX（PIC24FJ64GU205 TX
线）

边缘连接器

RA0 DBG0 ICSPDAT 边缘连接器

RA1 DBG1 ICSPCLK 边缘连接器

RA12 DBG2 SW0/GPIO 边缘连接器

— DBG3 MCLR 边缘连接器

VCC_Target VCC_LEVEL 电源电压 边缘连接器

GND GND 公共地 边缘连接器
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5. 硬件版本历史和已知问题
本用户指南提供了有关评估板最新可用版本的信息。以下章节包含有关已知问题、旧版版本历史以及旧版与最新版本
差异的信息。

5.1 标识产品 ID 和版本
可以通过两种方式找到 PIC24FJ64GU205 Curiosity Nano 的版本和产品标识：使用 MPLAB X IDE Kit Window（工具

包窗口）或查看 PCB 底部的标签。

将 PIC24FJ64GU205 Curiosity Nano 连接到运行 MPLAB X IDE 的计算机时，将弹出 Kit Window。工具包信息下列出

的序列号前六位数字包含产品标识和版本。

提示： 如果关闭了 Kit Window，可通过 MPLAB X IDE 中的菜单栏 Window > Kit Window 将其打开。

PCB 底部的标签上也提供相同的信息。大多数评估板都会以纯文本形式将标识和版本印刷为 A09-nnnn\rr，其中

“nnnn”是标识，而“rr”是版本。空间有限的评估板粘贴的标签上只有一个二维码，其中包含产品标识、版本和序列

号。

序列号字符串采用以下格式：

“nnnnrrssssssssss”

n = 产品标识

r = 版本

s = 序列号

PIC24FJ64GU205 Curiosity Nano 的产品标识为 A09-xxxx。
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6. 文档版本历史

文档版本 A（2021 年 2 月）

本文档的初始版本。
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7. 附录

7.1 原理图
图 7-1. PIC24FJ64GU205 Curiosity Nano 原理图
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7.2 装配图纸
图 7-2. PIC24FJ64GU205 Curiosity Nano 装配图纸（顶部）

PIC®
MCUb

图 7-3. PIC24FJ64GU205 Curiosity Nano 装配图纸（底部）
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7.3 适用于 Click 板的 Curiosity Nano 基板

图 7-4. PIC24FJ64GU205 Curiosity Nano 引脚排列映射
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7.4 断开板上调试器的连接
板上调试器和电平转换器可以与 PIC24FJ64GU205 完全断开连接。

以下框图给出了调试器与 PIC24FJ64GU205 之间的所有连接。圆角框表示与评估板边缘的连接。图中所示的信号名称

也会印刷在电路板底部的丝印层上。

要断开调试器，请切断图 7-6 所示的配置脚。

注意： 切断板上调试器所连接的 GPIO 配置脚将禁止虚拟串行端口、编程、调试和数据传输。切断电源配

置脚将断开板上电源的连接。

提示： 使用焊料重新连接所有之前切断的连接。或者，安装一个 0Ω的 0402 电阻。

提示： 断开调试器的连接后，可以将外部调试器连接到孔，如图 7-6 所示。有关连接外部调试器的详细信

息，请参见 3.6  连接外部调试器。

图 7-5. 板上调试器连接框图
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图 7-6. 板上调试器连接切断配置脚

GPIO straps (bottom side) Power Supply strap (top side)
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